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About Rittman Mead

Rittman Mead is a data and analytics company who specialise in data visualisation, predictive
analytics, enterprise reporting and data engineering.

We use our skKill, experience and know-how to work with organisations across the world to
iInterpret their data. We enable the business, the consumers, the data providers and IT to work
towards a common goal, delivering innovative and cost-effective solutions based on our
core values of thought leadership, hard work and honesty.

We work across multiple verticals on projects that range from mature, large scale
iImplementations to proofs of concept and can provide skills in development, architecture,
delivery, training and support.

info@rittmanmead.com www.rittmanmead.com Y @rittmanmead rittman mead



Oracle Analytics Cloud

* Oracle’s complete suite of Platform Services (PaaS) for unified analytics in the cloud

* Delivered entirely in the cloud:
» No infrastructure footprint
» Flexibility to scale up or down based on your immediate needs
» Simplified, metered licensing

Eagle Viminn Vetuaa! Reality

» Several options to suit your needs:
» Oracle or customer/partner managed services
» Functionality bundled into 3 editions
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* OAC supports every type of analytics workload across your organisation

* Classic enterprise Bl:

ORAC Le Analytics Cloud

Sales Analysis

Performance Indicators

13M

Revenue

» Analysis & dashboarding

Select Product Category:

(All Column Values) v

Select Geography:

ORACLE' Data Visualization

| Untitled - Project

» Published reporting

County
Bristol

Country

o
Oo  Data Elements
] United Kingdom

Full Name

» Enterprise Performance Management

e Donut

Il Trellis Columns

== Trellis Rows

* Modern departmental/personal discovery:

E3 Values (Slice)

# Of Orders

» Extended data mashup & modelling

ﬂ Category

lame

@& Color

A Country

» Data preparation, exploration & visualisation

Y Filters

» Data science & machine learning

Canvas1 ¥ ©

This measure represents
entarprise revenue for the

Q, Advanced Administration

Search All v Help w Sign Out  #nun
Home Catalog Favorites w Dashboards v New v Open v Signed In As  Mike Vickers v
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Mapping in OAC - The Old Way

Add Connection -

’ The ablllty to pIOt data On maps IS nOt neW' "t <map_data_source name="O0A_HERE_MAPS" ﬁ:r =
» Achievable since OBIEE 11g

» Remains available as a Classic feature

jdbc_host="<ip_Address>"
jdbc_sid="//<service_name>"
jdbc_port="1521"
jdbc_user="oa_here_maps"
jdbc_password=""!Admin123"
jdbc_mode="thin" Test Connection @
number_of_mappers="10" —= o —
allow_jdbc_theme_based_foi="true"

editable="true"

P & W 00 N O Ul A W IN B

[ [

/>

* ...but never simple to implement...
» Based on SDO_GEOMETRY . o .
» Maps constructed through MapBuilder —

4 Internal Tile layer

» Layers configured in MapViewer R ——
» Integrated through OBIEE Administration

* ...and often hit performance challenges
» Multiple database calls
» Limited ability to cache layers

rittmanmead
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Mapping in OAC - The New Way

- Data Visualisation (DV) introduced a new approach

» System maps & layers available
» Ability to create custom maps & layers
» Quick and simple joining to data sets

- requires no manual intervention
- but default preferences can be set
* Visually impactful
» Draw out hidden geographical insights
» Interact with data

- lasso data points
- keep/remove selected, drill, zoom etc.

* Better performance
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"FeatureCollection"
"Major Towns _and_| C1t1es December_2015 Boundarxes
": “name", “"properties": { "name": "urn:ogc: def:crs:06C:1.3: CRSBA™ }),

“type": "Feature", "properties": { "OBJECTID": 1, " TCITYISCD "Jo1000001" YCITY]SNH “Barn
53.596403490734602 ],
53.595948047176996 ],
53.595944993051297 ],
53.595043127138197 ],
53.594587644981303 ],
53.594132045482901 ],
53.593676516344203 ],

Backgrounds Map Layers !

Map Layer

[
[ -
£z
4 Custom Map Layers :

sley", Shape Area"

7032397 1

[
[
(
[
[
(
I

25682473.450256299, Shape Length 115099. 859999992 }, geometry { "typ e “Polygon" coordmates cer-. 514195344162036
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= & g 42603197 ],
85724698 ],
994571501 ],
123371203 ],
503749997 ],
984705602 ],

-1. 51193419935117,
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-1.50968336910322,
-1.50817776897365,
-1.50667207876017,
-1.50516654218459,

-1.50 1872

Include Name Name

Towns_and_Cities_England_Wales

No custom map layers have been uploaded

Description

| 0 Add Custom Layer (click, or drag and drop GeoJSON file)

*Layer Keys

Location Details: Code

OBJECTID

Shape__Area

to
Your Data fatch ¥ Match Quality Shape Length
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Map Components

* Maps have 3 main components

» Background Map

- canvas for the visualisation
- Image or service based
- includes relevant feature layers

» Map Layer

- defines the geometry of the data
- array of coordinates
- polygons or points

» Data

- measures to be visualised
- key attribute that joins to layer data
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Background Maps

* Provides the context for the visualisation

» World map e
» Store layout etc.
 Grain set by adding detailed layers |
. ) apublint Wereoo oD @' R tver " Seffigls
» Country boundaries ¢ S Sl e
» Road networks 3 g
- o & Dunkerque o ] il g e
» Green spaces etc. o 1 A
* 3 system maps provided

» Oracle Bl
» Oracle Maps

» OpenStreetMaps
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Map Layers

{

"type": "FeatureCollection",
"features": [

{ "type": "Polygon", "coordinates": [ [

» Specifies the boundaries or points of interest

53.506394342603197
1934156301
3127138197
6994571501

» Defined in geojson format

—— 4571840798
Backgrounds Map Layers gggg;gggg;

- feature properties mustinclude a key value 7076858803
) Custom Map Layers 0887783502

8427032397

4 System Map Layers N0 A0/

- geometry array defines the polygon or point

» System layers are available ¥ UsaCites
» US boundaries : j:
» World boundaries ¥ Word Cities
v Word Continents
* Custom layers can be uploaded : Wortd Gounirie
» Source or create geojson input y x:g

» Specify the layer key
» Note: 25MB limit

{ "type": "Feature", "properties": { "QBJECTID": 1,
"Barnsley", "Shape__Area": 25682473.450256299, "Shape__Length": 115099.859999992 }, "geometry":

"name": "Major_Towns_and_Cities__December_2015__Boundaries",
"crs": { "type": "name", "properties": { "name": "urniogc:ideficrsi0GC:1,3:CRS84" } },

[ -1.51419534462036, 53.596403490734602 1,

]
]
]
]
]
]
]
]
]
]
]

[

-1.

-1

-1

51268446259955,

.51193419935117,
-1.
-1.
-1.
-1.
.50742224739603,
-1.
-1.
-1.
-1.

51118395294859,
51043358523477,
50968336910322,
50893316982128,

50667207876017,
50592192677058,
50517178954178,
50366090051872,

Name

Description

OBJECTID

*Layer Keys

Shape__Area
Shape__Length
/| TCITY15CD

TCITY15NM

[ -1.51343990354121, 53.5964004461269 1, [ -1.51344506539145, 53.595951096533298 ],
[ -1.51268963230247, 53.595948047176996
[ —1.511929A2179K58.

.596397396749801
.595944993051297
.595492485724698
.595040062963903
.594587644981303
.594135123371203
.594128962331901
.593676516344203
.593223984705602
.592771529198401
.592765320531299

Towns_and_Cities_England_Wales

Cancel Update

"TCITY15CD": "J01000001", "TCITY15NM":

S RO S S VR S S S— ——]
N T T T T TSR S
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* Your data set must include

» The measures that you wish to view

» The layer key value

* Configure the map

» Set the Background Map

» Select the Map Layer

- on the fly or in advance
- set presentation options

* Set visual grammar Assignments

» Colour
» Size
» Tooltips

< |22 Population 2009

& Population of Major Towns & Cities ... © Click here or drag data to add a filter

di
Wy Map

Auto E= Trellis Rows

Map Layer Auto (Towns and Cities England Wales) ® Code Layer v

Layer Type Auto (Point) a Category (Lo

Transparency 30 Code

Tooltip
. a @& Color

Show Layer

iii Trellis Columns

cation)

Location Details: Code

and Cities En... v 100 Locations

Map Layer Towns

Your Data Match T Match Quality

J01000001 J01000001 100% Confidence

J01000002 J01000002

100% Confidence

100% Confidence

11000004 100% Confidence

11000005 100% Confidence

v | | Population of Major Towns & Cities in England & Wales (2009) 11000006 100% Confidence

11000008 100% Confidence

11000009 100% Confidence

21000010 100% Confidence

01000011 100% Confidence

)1000012 100% Confidence

11000016 100% Confidence

Cancel
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Available from OAC 5.9

* Ability to create new custom background maps types, based on

» Web Map Service (WMS) ;
» Tiles Web Map (XYZ) ¢
f
]
-5;: “t PR TR NN ) 328 S Sl
* Massively increases mapping options g ks Sh

» Many maps openly available

* Enables otherwise impossible analysis <
» None-infrastructure based layers

- climate
- demography
- air quality etc.
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Web Map Services

* A universal map protocol introduced

by the Open Geospatial Consortium
(OGC)

» Simple HTML interface
» Distributed goespatial databases

» Based on map images (JPEG, PNG
etc.)

« Simple to subscribe to the service and
issue requests for required maps

m
O GC®
Making location count.

ABOUT v MEMBERSHIP v STANDARDS & RESOURCES v

INNOVATION v NEWS & EVENTS v

S .

B —

[Sts &
¢

EO Apps Pilot

Engineering Reports:

How to develop, deploy, and share EO  "SSSues
Processing Apps for any Cloud Platform [ S ua
A i . "‘w-

The Home of Location Technology Innovation and Collaboration IEEE S

—‘/:__- r? sl .} - s Sof

e OGC Member Portal Training
13 Apr- 13 Apr

e Geolgnite 2021
22 Apr - 22 Apr

e Geospatial is Everywhere - now what?
27 Apr-27 Apr

e CUF: Canada's Underground

Infrastructure Mapping Forum (as part

Your Global Resource for Geospatial Information and Standards

Welcome to OGC, a worldwide community committed to improving access to geospatial, or location information.
We connect people, communities, and technology to solve global challenges and address everyday needs. The
organization represents over 500 businesses, government agencies, research organizations, and universities
united with a desire to make location information FAIR - Findable, Accessible, Interoperable, and Reusable.

~ VoVl 2|
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WMS - GetCapabilities

* The WMS definition can be found by
referencing the GetCapabilities request

» Available on most sites offering WMS

» Access via the WMS Server URL
- pass the request=GetCapabilities variable

* The definition includes everything needed
» URL
» WMS Version (e.g. 1.3.0
» Available Formats (e.g. PNG, JPG etc.
» Layer definitions

c ﬁl uk-air.defra.gov.uk/view/services/PCM/PM10Roads/MapServer/WMSServer S

This XML file does not appear to have any style information associated with it. The document tree is shown b

Version

V<WMS_Capabilities xmlns="http://www.opengis.net/wms" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"” xmlns:esri_wms="http://www.esri.com/wms"
http://schemas.opengis.net/wms/1.3.0/capabilities_1_3_0.xsd http://www.esri.com/wms https://ukairmaps.ricardo-aea.com/server/services/PCM_2018/PM10R

version=1.3.0%26service=WMS$26request=GetSchemaExtension">
v<Service>

v <Name>
<![CDATA[ WMS ])>
</Name>
<Title>WMS</Title>

<Abstract>WMS</Abstract>
v<KeywordList>

v <Keyword>

<I[CDATA[ ])>
</Keyword>

</KeywordList>

<OnlineResource xmlns:xlink="http://www.w3.0rg/1999/xlink" xlink:type="simple" xlink:href="https://ukairmaps.ricardo-aea.com/server/services/PCM_2018/PM10Roads/MapServer/Wms:
» <ContactInformation>

</ContactInformation>
» <Fees>
</Fees>
» <AccessConstraints>
</AccessConstraints>
<MaxWidth>4096</MaxWidth>
<MaxHeight>4096</MaxHeight>
</service>
v<Capability>
v <Request>
v<GetCapabilities>
lication/vnd.ogc.wms_xml</Format>
/xml</Format>

</style>

<llayer

Y<Layer queryable="1">

eResource xmlns:xlink="http://wy <Name>18</Name>
< v<Title>
</HT <![CDATA[ 2018 ]]>
</DCPT! </Title>
</GetCap¥bilities> itle
v <GatMan v<Abstract>

<Format>image/bmp</Format>
<Format>image/jpeg</Format>
<Format>image/tiff</Format>
<Format>image/png</Format>
<Format>image/png8</Format>
<Format>image/png24</Format>
<Format>image/png32</Format>
<Format>image/gif</Format>
<Format>image/svg+xml</Format>

<![CDATA[ ]]>
</Abstract>
<CRS>CRS:84</CRS>
<CRS>EPSG:4326</CRS>
<CRS>EPSG:27700</CRS>

<§éstBoundLongitude>—8.163680</westBoundLongitude>
<eastBoundLongitude>2.273974</eastBoundLongitude>

;2;;;;: <southBoundLatitude>50.053455</southBoundLatitude>
v<Get> <northBoundLatitude>57.694688</northBoundLatitude>
<OnlineResource xmlns:xlink="http://w« </EX_GeographicBoundingBox>
</Get> <BoundingBox CRS="CRS:84" minx="-8.163680" miny="50.053455" maxx="2.273974" maxy="57.694688"/>
. | <BoundingBox CRS="EPSG:4326" minx="50.053455" miny="-8.163680" maxx="57.694688" maxy="2.273974"/>
<BoundingBox CRS="EPSG:27700" minx="31389.913700" miny="29826.290000" maxx="655159.000000" maxy="867179.000000"/>
v<Style>
<Name>default</Name>
<Title>18</Title>

v<LegendURL width="72" height="162">
<Format>image/png</Format>
<OnlineResource xmlns:xlink="http://www.w3.0rg/1999/xlink" xlink:href="https://ukairmaps.ricardo-aea.com/server/servi
request=GetLegendGraphic%26version=1.3.0%26format=image/png%26layer=18" xlink:type="simple"/>
</LegendURL>
</style>
</Layer>
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Create a Custom WMS Map

— Console

Analytics

« Background Maps & Layers are configured via Ve SR e

Catalog

the Console "
} NaVigate to the ConSOIe Machine Learning Extensions
» Select Maps

Jobs

Backgrounds Map Layers

- WMS Maps are added on the Backgrounds o b . Smains

-ta b v Background Particulates 2008

» Navigate to the Background Maps P —
» Click on Add Background
» Select Web Map Service

Background Particulates 2018 " @

EEA Drought Frequency Change hots Virus Scanner
EEA Hydrography

OpenStreetMap General purpose baf

Oracle Bl Thematic world mag

Oracle Maps General reference w

Ozone Density 2018

Roadside Particulates 2008

Roadside Particulates 2013

AN N N U N N N U N

Roadside Particulates 2018

0 Add Background

» Google Maps

Baidu Maps

Web Map Service
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Configure the WMS Map

» Configure the WMS map, providing:
» Name

- the identifier visible within DV
» Description

- an optional descriptive for the map
» URL

- the location of the WMS service

- specified upto /MapServer/WMSServer
» Version

- the version referenced by the WMS service
» Layers

- one (or more) layers defined in the WMS service
» Format

- a valid format defined in the WMS service

EEA Drought Frequency Change

EEA Drought Frequency Change

General
Name EEA Drought Frequency Change

Parameters Description

Preview
URL  https://climate.discomap.eea.europa.e

v/ | agree to trust this external host.More Details

Version 1.3.0 v
Coordinate
Reference System Bt o
Layers | 1 %
Format PNG v

Setup Details and Troubleshooting Tips
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Create Safe Domain Entry

EEA Drought Frequency Change
* In order for OAC to be able to reference the EEA Drought Frequency Change

WMS SerViCG, the URL mUSt be added tO the CEe Name EEA Drought Frequency Change
Safe Domain IiSting Parameters Description

} CIICk On the CheCk bOX to Create an entry e URL  https://climate.discomap.eea.europa.e

» Configure domains via the Safe Domains

option on the Console Version | 130 :

Coordinate
Reference System £ S&:3857 i )

< O safe Domains

Embedding

o
<1
3
D
5
=z
o
3
®
E)
@
(<]
°
3
5
®
23

=
Q
«Q
=
AN AN AN AN AN AN AN AN AN AN AN 2

Allow Frames Script Font Style Media

AN AN AN AN AN AN AN AN
AN AN AN AN AN AN AN AN AN AN AN

mnanmead
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Confirm the WMS Map Configuration

* Preview the WMS Map
» Click on Save
» Refresh your OAC session

» Open the new WMS entry
- access the Options menu
- click on Inspect

» Navigate to the Preview tab
- confirm the map is rendered

EEA Drought Frequency Change

EEA Drought Frequency Change

General

Parameters =

Preview

500 mi
1000 km
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Use the WMS Map

< | |&2 Population

* Create a Project
» Add a Map to the Canvas

) Configure the Map My Calculations
- open the Properties e SR
- havigate to the Maps tab
- expand the Background Map
options
- select the newly added map

Roadside Particulates 2018
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Add Context

) ] o ) <VALUE>
Population of Major Towns & Cities in England & Wales (2009)

-~ W

-17

* As the map layers may not be limited to
infrastructure features, it is important to
make clear what the background is
showing

» Check the GetCapabilities request
» The service should include legend details
- search for <LegendURL> tag

» Add an Image visualisaton to the DV
Canvas

- specify the LegendURL

v<LegendURL width="72" height="162">
<Format>image/png</Format>
<OnlineResource xmlns:xlink="http://www.w3.0rg/1999/xlink" xlink:href="https://ukairmaps.ricardo-
aea.com/server/services/PCM_2018/PM10/MapServer/WmsServer?
request=GetLegendGraphic%26version=1.3.0%26format=image/png%26layer=8" xlink:type="simple"/> F
</LegendURL>
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Demonstration
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Summary

* Integrating Web Map Services opens up
new and innovative ways in which our
enterprise data sets can be analysed

* Helping us to gain a better understanding
and identify insights that would otherwise
be missed

* WMS services can be integrated into your
OAC environment quickly and very easily,
opening up a world of opportunities!
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Any Questions?
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